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受講の目的・動機等（事前アンケートに基づくまとめ）
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⽣物画像解析についての知識を深めたい
画像解析のコツを知りたい

画像解析研究者の視点を知りたい
最新の画像解析⼿法について情報収集

⾃⾝の研究・業務に役⽴てたい

QuPath、napariを⽤いた解析を学びたい

ImageJを⽤いた⽣物画像解析を学びたい

AIを⽤いた⽣物画像解析について知りたい



講義の概要
• 講義内容

• この講義では、生物画像解析における主要なタスクに焦点を当て、
実践的な戦略と具体的なアプローチをImageJ/Fiji、QuPath、napariといった画像
解析ツールを用いて解説します。

• 目標
• 生物画像解析の実践的な考え方を理解し、適切な手法を選択できる
能力を養うことを目指します。
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本講義で扱う内容と扱わない内容
• 本講義で扱う内容

• 生物画像解析の実践に必要な考え方
• オープンソース生物画像解析ソフトウェアを用いた生物画像解析の実例
• 生物画像解析を行なっていくために必要な情報の調べ方

• 本講義で扱わない内容
• 個々のソフトウェアの使い方の詳細
• 画像解析により得られた結果の統計処理
• プログラミング
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生物画像解析の一般的な流れ
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課題設定

解析方針決定
ツール選択

解析実行

結果の解釈

Microsoft Stock Images の画像を利用



生物画像解析の一般的な流れ
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課題設定

解析方針決定
ツール選択

解析実行

結果の解釈

ここがまず重要！
Microsoft Stock Images の画像を利用



課題設定の例
• 細胞の画像解析をしたい
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課題設定の例
• 細胞の画像解析をしたい

• 蛍光顕微鏡で撮像した核染色画像を用いて、画像内全領域における個々の
細胞核の面積を定量したい
• 病理スライド画像を用いて、正常細胞領域とがん細胞領域の比率を定量し
たい
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課題設定によって適切な解析方針や選択するツールが異なる

課題設定を明確にする



解析方針の検討
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• 課題の目的

• 入力画像の性質

• 利用可能なツール

• 利用可能な計算機環境

などを踏まえて解析方法の検討を行う



主な画像解析タスク
• 分類
• 物体検出
• セマンティックセグメンテーション
• インスタンスセグメンテーション
• 形態解析
• トラッキング
• その他（共局在解析、デノイズなど）
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キーワードを知っておくと便利



主な画像解析タスク
• 分類
• 物体検出
• セマンティックセグメンテーション
• インスタンスセグメンテーション
• 形態解析
• トラッキング
• その他（共局在解析、デノイズなど）
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画像データ: the C.elegans infection live/dead image set version 1 provided by Fred 
Ausubel and available from the Broad Bioimage Benchmark Collection [Ljosa et 
al., Nature Methods, 2012].
Moy et al. ACS Chem. Biol. 4(7). 527-533 (2009). https://doi.org/10.1021/cb900084v
Wählby, C. et al. Nat Methods 9, 714‒716 (2012). https://doi.org/10.1038/nmeth.1984

Positive: mostly alive Negative: mostly dead

二種類以上のクラスに画像を分類するタスク

http://dx.doi.org/10.1038/nmeth.2083
http://dx.doi.org/10.1038/nmeth.2083
https://doi.org/10.1021/cb900084v
https://doi.org/10.1038/nmeth.1984


主な画像解析タスク
• 分類
• 物体検出
• セマンティックセグメンテーション
• インスタンスセグメンテーション
• 形態解析
• トラッキング
• その他（共局在解析、デノイズなど）
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画像データ: BBBC039v1 Caicedo et al. 2018, the Broad Bioimage Benchmark 
Collection [Ljosa et al., Nature Methods, 2012] CC0

画像内の対象オブジェクトを検出するタスク

https://bbbc.broadinstitute.org/bbbc/BBBC039
http://dx.doi.org/10.1038/nmeth.2083


主な画像解析タスク
• 分類
• 物体検出
• セマンティックセグメンテーション
• インスタンスセグメンテーション
• 形態解析
• トラッキング
• その他（共局在解析、デノイズなど）
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画像内の領域を対象クラスごとに分割

画像データ: OpenSlide Test data OS-2.ndpi 
https://openslide.cs.cmu.edu/download/openslide-testdata/Hamamatsu/

セグメンテーション結果元画像

https://openslide.cs.cmu.edu/download/openslide-testdata/Hamamatsu/


主な画像解析タスク
• 分類
• 物体検出
• セマンティックセグメンテーション
• インスタンスセグメンテーション
• 形態解析
• トラッキング
• その他（共局在解析、デノイズなど）
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個々の対象オブジェクトの輪郭を検出するタスク

画像データ: BBBC039v1 Caicedo et al. 2018, the Broad Bioimage Benchmark 
Collection [Ljosa et al., Nature Methods, 2012] CC0

Fiji: https://imagej.net/ による解析
Schindelin, J. et al., (2012). Nature Methods, 9(7), 676–682. doi:10.1038/nmeth.2019

https://bbbc.broadinstitute.org/bbbc/BBBC039
http://dx.doi.org/10.1038/nmeth.2083
https://imagej.net/
https://doi.org/10.1038/nmeth.2019


主な画像解析タスク
• 分類
• 物体検出
• セマンティックセグメンテーション
• インスタンスセグメンテーション
• 形態解析
• トラッキング
• その他（共局在解析、デノイズなど）
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検出オブジェクトの形態情報を解析するタスク

画像データ: BBBC039v1 Caicedo et al. 2018, the Broad Bioimage Benchmark 
Collection [Ljosa et al., Nature Methods, 2012] CC0

ID 面積 平均輝度 …

1 10.0 20.0

2 15.5 32.2

3 20.1 17.8

…

Fiji: https://imagej.net/ による解析
Schindelin, J. et al., (2012). Nature Methods, 9(7), 676–682. doi:10.1038/nmeth.2019

https://bbbc.broadinstitute.org/bbbc/BBBC039
http://dx.doi.org/10.1038/nmeth.2083
https://imagej.net/
https://doi.org/10.1038/nmeth.2019


主な画像解析タスク
• 分類
• 物体検出
• セマンティックセグメンテーション
• インスタンスセグメンテーション
• 形態解析
• トラッキング
• その他（共局在解析、デノイズなど）
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対象オブジェクトを追跡し解析するタスク

画像データ: C.elegans AZ212 H2B-eGFP 胚発生データ Celegans-5pc-17timepoints.tif (94 MB).
Tinevez, J.-Y., TrackMate tutorial (https://imagej.net/plugins/trackmate/tutorials/manual-track-editing) 

TrackMate: https://imagej.net/plugins/trackmate/ による解析
Tinevez, J.-Y. et al., (2017). Methods, 115. doi:10.1016/j.ymeth.2016.09.016

http://samples.fiji.sc/Celegans-5pc-17timepoints.tif
https://imagej.net/plugins/trackmate/tutorials/manual-track-editing
https://imagej.net/plugins/trackmate/
https://doi.org/10.1016/j.ymeth.2016.09.016


生物画像解析オープンソースソフトウェアの歴史
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1987
NIH Image1

アメリカ国⽴衛⽣研究所の
Wayne RasbandがMac向けに開発
した汎⽤画像解析ソフトウェア
ImageJの元となった

各ソフトウェアのロゴ引用元: https://imagej.net/software/

1. Schneider, C. A., Rasband, W. S., & Eliceiri, K. W. (2012).
Nature Methods, 9(7), 671–675. doi:10.1038/nmeth.2089

https://imagej.net/software/
https://doi.org/10.1038/nmeth.2089


生物画像解析オープンソースソフトウェアの歴史
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1987
NIH Image1

1997
ImageJ1

Javaによりクロスプラットフォーム
で利⽤できるようになりユーザー
と開発者の数が⼤幅に増加

1. Schneider, C. A., Rasband, W. S., & Eliceiri, K. W. (2012).
Nature Methods, 9(7), 671–675. doi:10.1038/nmeth.2089

各ソフトウェアのロゴ引用元: https://imagej.net/software/

https://doi.org/10.1038/nmeth.2089
https://imagej.net/software/


生物画像解析オープンソースソフトウェアの歴史
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1987
NIH Image1

1997
ImageJ1

2005
CellProfiler2

ハイスループットスクリーニング
を主な対象として開発された
モジュール化された機能を組み合
わせて解析パイプラインを作成

1. Schneider, C. A., Rasband, W. S., & Eliceiri, K. W. (2012).
Nature Methods, 9(7), 671–675. doi:10.1038/nmeth.2089

2. Carpenter, A. E. et al., (2006). Genome Biology, 7(10), R100.
doi:10.1186/gb-2006-7-10-r100

各ソフトウェアのロゴ引用元: https://imagej.net/software/

https://doi.org/10.1038/nmeth.2089
https://doi.org/10.1186/gb-2006-7-10-r100
https://imagej.net/software/


生物画像解析オープンソースソフトウェアの歴史
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1987
NIH Image1

1997
ImageJ1

2005
CellProfiler2

ImageJを元に拡張性を向上
頻⽤されるプラグインを初期搭載
したFijiがコミュティで⼈気となる

2. Carpenter, A. E. et al., (2006). Genome Biology, 7(10), R100.
doi:10.1186/gb-2006-7-10-r100

1. Schneider, C. A., Rasband, W. S., & Eliceiri, K. W. (2012).
Nature Methods, 9(7), 671–675. doi:10.1038/nmeth.2089

2012
ImageJ23/Fiji4

3. Rueden, C. T. et al. (2017). BMC Bioinformatics, 18(1). doi:10.1186/s12859-017-1934-z
4. Schindelin, J. et al., (2012). Nature Methods, 9(7), 676–682. doi:10.1038/nmeth.2019

各ソフトウェアのロゴ引用元: https://imagej.net/software/

https://doi.org/10.1186/gb-2006-7-10-r100
https://doi.org/10.1038/nmeth.2089
https://doi.org/10.1186/s12859-017-1934-z
https://doi.org/10.1038/nmeth.2019
https://imagej.net/software/


生物画像解析オープンソースソフトウェアの歴史
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1987
NIH Image1

1997
ImageJ1

2012
ImageJ23/Fiji4

2005
CellProfiler2

2017
QuPath5

病理画像(ホールスライド画像)を
主な対象として開発された
病理画像解析向け機能を多数搭載

2. Carpenter, A. E. et al., (2006). Genome Biology, 7(10), R100.
doi:10.1186/gb-2006-7-10-r100

1. Schneider, C. A., Rasband, W. S., & Eliceiri, K. W. (2012).
Nature Methods, 9(7), 671–675. doi:10.1038/nmeth.2089

3. Rueden, C. T. et al. (2017). BMC Bioinformatics, 18(1). doi:10.1186/s12859-017-1934-z
4. Schindelin, J. et al., (2012). Nature Methods, 9(7), 676–682. doi:10.1038/nmeth.2019

5. Bankhead, P. et al., (2017). Scientific Reports, 7(1).
 doi:10.1038/s41598-017-17204-5

各ソフトウェアのロゴ引用元: https://imagej.net/software/

https://doi.org/10.1186/gb-2006-7-10-r100
https://doi.org/10.1038/nmeth.2089
https://doi.org/10.1186/s12859-017-1934-z
https://doi.org/10.1038/nmeth.2019
https://doi.org/10.1038/s41598-017-17204-5
https://imagej.net/software/


生物画像解析オープンソースソフトウェアの歴史
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2005
CellProfiler2

2018
napari6

Pythonベースの多次元対応画像解析
ソフトウェア
PythonとAIの普及に伴い⼈気となる

2. Carpenter, A. E. et al., (2006). Genome Biology, 7(10), R100.
doi:10.1186/gb-2006-7-10-r100

2012
ImageJ23/Fiji4

1987
NIH Image1

1997
ImageJ1

1. Schneider, C. A., Rasband, W. S., & Eliceiri, K. W. (2012).
Nature Methods, 9(7), 671–675. doi:10.1038/nmeth.2089

3. Rueden, C. T. et al. (2017). BMC Bioinformatics, 18(1). doi:10.1186/s12859-017-1934-z
4. Schindelin, J. et al., (2012). Nature Methods, 9(7), 676–682. doi:10.1038/nmeth.2019

2017
QuPath5

5. Bankhead, P. et al., (2017). Scientific Reports, 7(1).
 doi:10.1038/s41598-017-17204-5

6. Sofroniew, N. et al., (2024). Zenodo.
doi:10.5281/ZENODO.3555620

各ソフトウェアのロゴ引用元: https://imagej.net/software/

https://doi.org/10.1186/gb-2006-7-10-r100
https://doi.org/10.1038/nmeth.2089
https://doi.org/10.1186/s12859-017-1934-z
https://doi.org/10.1038/nmeth.2019
https://doi.org/10.1038/s41598-017-17204-5
https://doi.org/10.5281/ZENODO.3555620
https://imagej.net/software/


生物画像解析オープンソースソフトウェアの歴史
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• オープンソース
• マクロ・プラグインによる拡張
• マルチプラットフォーム

という特徴を持つソフトウェアが人気

2005
CellProfiler2

2018
napari6

2. Carpenter, A. E. et al., (2006). Genome Biology, 7(10), R100.
doi:10.1186/gb-2006-7-10-r100

2012
ImageJ23/Fiji4

1987
NIH Image1

1997
ImageJ1

1. Schneider, C. A., Rasband, W. S., & Eliceiri, K. W. (2012).
Nature Methods, 9(7), 671–675. doi:10.1038/nmeth.2089

3. Rueden, C. T. et al. (2017). BMC Bioinformatics, 18(1). doi:10.1186/s12859-017-1934-z
4. Schindelin, J. et al., (2012). Nature Methods, 9(7), 676–682. doi:10.1038/nmeth.2019

2017
QuPath5

5. Bankhead, P. et al., (2017). Scientific Reports, 7(1).
 doi:10.1038/s41598-017-17204-5

6. Sofroniew, N. et al., (2024). Zenodo.
doi:10.5281/ZENODO.3555620

各ソフトウェアのロゴ引用元: https://imagej.net/software/

https://doi.org/10.1186/gb-2006-7-10-r100
https://doi.org/10.1038/nmeth.2089
https://doi.org/10.1186/s12859-017-1934-z
https://doi.org/10.1038/nmeth.2019
https://doi.org/10.1038/s41598-017-17204-5
https://doi.org/10.5281/ZENODO.3555620
https://imagej.net/software/


生物画像解析オープンソースソフトウェアの歴史
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本講義では、Fiji, QuPath, napariを用いた実用例を紹介する

2005
CellProfiler2

2018
napari6

2. Carpenter, A. E. et al., (2006). Genome Biology, 7(10), R100.
doi:10.1186/gb-2006-7-10-r100

2012
ImageJ23/Fiji4

1987
NIH Image1

1997
ImageJ1

1. Schneider, C. A., Rasband, W. S., & Eliceiri, K. W. (2012).
Nature Methods, 9(7), 671–675. doi:10.1038/nmeth.2089

3. Rueden, C. T. et al. (2017). BMC Bioinformatics, 18(1). doi:10.1186/s12859-017-1934-z
4. Schindelin, J. et al., (2012). Nature Methods, 9(7), 676–682. doi:10.1038/nmeth.2019

2017
QuPath5

5. Bankhead, P. et al., (2017). Scientific Reports, 7(1).
 doi:10.1038/s41598-017-17204-5

6. Sofroniew, N. et al., (2024). Zenodo.
doi:10.5281/ZENODO.3555620

各ソフトウェアのロゴ引用元: https://imagej.net/software/

https://doi.org/10.1186/gb-2006-7-10-r100
https://doi.org/10.1038/nmeth.2089
https://doi.org/10.1186/s12859-017-1934-z
https://doi.org/10.1038/nmeth.2019
https://doi.org/10.1038/s41598-017-17204-5
https://doi.org/10.5281/ZENODO.3555620
https://imagej.net/software/


ソフトウェアのインストール
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https://imagej.net/software/fiji/downloadsFiji

napari https://napari.org/stable/tutorials/fundamentals/quick_start.html#installation

各ソフトウェアのロゴ引用元: https://imagej.net/software/

QuPath https://qupath.readthedocs.io/en/stable/docs/intro/installation.html

最新の公式ドキュメントの手順に従いソフトウェアのインストールを行う
（本講義ではインストール方法の詳細は紹介しない）

https://imagej.net/software/fiji/downloads
https://napari.org/stable/tutorials/fundamentals/quick_start.html
https://imagej.net/software/
https://qupath.readthedocs.io/en/stable/docs/intro/installation.html


課題1: 蛍光染色した核の面積定量
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元画像 解析結果

画像データ: BBBC039v1 Caicedo et al. 2018, the Broad Bioimage Benchmark Collection [Ljosa et al., Nature Methods, 2012]

個々の核をセグメンテーションし、面積の定量を行う

Fiji: https://imagej.net/ による解析
Schindelin, J. et al., (2012). Nature Methods, 9(7), 676–682. doi:10.1038/nmeth.2019

https://bbbc.broadinstitute.org/bbbc/BBBC039
http://dx.doi.org/10.1038/nmeth.2083
https://imagej.net/
https://doi.org/10.1038/nmeth.2019


課題1: 解析方針の検討
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画像データ: BBBC039v1 Caicedo et al. 2018, the Broad Bioimage Benchmark Collection [Ljosa et al., Nature Methods, 2012]

• 画像サイズは？
￫ 696 x 520 (XY)と小さい
￫ Fiji1で対応可能

• 核の領域は蛍光シグナルが大きい
￫ 検出対象（核）と背景を区別することが必要
￫ 二値化とラベリングの組み合わせが使えそう

• ノイズ除去が必要か？
￫ 必要であればフィルタリングを二値化前に追加

• 隣接している核がある
￫ 隣接領域を分離ための処理を追加

1. Fiji: https://imagej.net/ 
Schindelin, J. et al., (2012). Nature Methods, 9(7), 676–682. doi:10.1038/nmeth.2019

https://bbbc.broadinstitute.org/bbbc/BBBC039
http://dx.doi.org/10.1038/nmeth.2083
https://imagej.net/
https://doi.org/10.1038/nmeth.2019


課題1: 解析方針の決定
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画像データ: BBBC039v1 Caicedo et al. 2018, the Broad Bioimage Benchmark Collection [Ljosa et al., Nature Methods, 2012]

元画像 平滑化 前景/背景二値化

隣接領域の分離ラベリング面積の定量

Fiji: https://imagej.net/ による解析
Schindelin, J. et al., (2012). Nature Methods, 9(7), 676–682. doi:10.1038/nmeth.2019

https://bbbc.broadinstitute.org/bbbc/BBBC039
http://dx.doi.org/10.1038/nmeth.2083
https://imagej.net/
https://doi.org/10.1038/nmeth.2019


ガウシアン平滑化
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画像データ: BBBC039v1 Caicedo et al. 2018, the Broad Bioimage Benchmark Collection [Ljosa et al., Nature Methods, 2012]

ガウシアン平滑化の他、平均化（Mean）やメディアン（Median）が良く使われる

ガウシアン平滑化 | 元画像

Fiji: https://imagej.net/ による解析
Schindelin, J. et al., (2012). Nature Methods, 9(7), 676–682. doi:10.1038/nmeth.2019

https://bbbc.broadinstitute.org/bbbc/BBBC039
http://dx.doi.org/10.1038/nmeth.2083
https://imagej.net/
https://doi.org/10.1038/nmeth.2019


前景/背景二値化（Otsu1法）
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画像データ: BBBC039v1 Caicedo et al. 2018, the Broad Bioimage Benchmark Collection [Ljosa et al., Nature Methods, 2012]

Otsu法の他、様々な自動二値化手法がある（Image > Adjust > Auto Threshold参照）

二値化 | ガウシアン平滑化

1. Otsu, N. (1978). IEEE Transactions on on Systems, Man, and Cybernetics, 9(1), 62–66. doi:10.1109/TSMC.1979.4310076

Fiji: https://imagej.net/ による解析
Schindelin, J. et al., (2012). Nature Methods, 9(7), 676–682. doi:10.1038/nmeth.2019

https://bbbc.broadinstitute.org/bbbc/BBBC039
http://dx.doi.org/10.1038/nmeth.2083
https://doi.org/10.1109/34.87344
https://doi.org/10.1109/TSMC.1979.4310076
https://imagej.net/
https://doi.org/10.1038/nmeth.2019


隣接領域の分離（Watershed1法）
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画像データ: BBBC039v1 Caicedo et al. 2018, the Broad Bioimage Benchmark Collection [Ljosa et al., Nature Methods, 2012]

Watershed | 二値化

二値化画像に距離変換*を適用しWatershed法による分離を実施
* 各前景ピクセルについて最近傍背景ピクセルまでの距離を算出

1. Vincent, L., & Soille, P. (1991). IEEE Transactions on Pattern Analysis and Machine Intelligence, 13(6), 583–598. doi:10.1109/34.87344

Fiji: https://imagej.net/ による解析
Schindelin, J. et al., (2012). Nature Methods, 9(7), 676–682. doi:10.1038/nmeth.2019

https://bbbc.broadinstitute.org/bbbc/BBBC039
http://dx.doi.org/10.1038/nmeth.2083
https://doi.org/10.1109/34.87344
https://imagej.net/
https://doi.org/10.1038/nmeth.2019


ラベリングと面積の定量
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画像データ: BBBC039v1 Caicedo et al. 2018, the Broad Bioimage Benchmark Collection [Ljosa et al., Nature Methods, 2012]

ラベル | Watershed

面積の他、輝度や形態の定量値を解析することが可能

必要に応じてImage > Properties...
からピクセルスケールを設定する

Fiji: https://imagej.net/ による解析
Schindelin, J. et al., (2012). Nature Methods, 9(7), 676–682. doi:10.1038/nmeth.2019

https://bbbc.broadinstitute.org/bbbc/BBBC039
http://dx.doi.org/10.1038/nmeth.2083
https://imagej.net/
https://doi.org/10.1038/nmeth.2019


Macro recorderによる自動化（動画）
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画像データ: BBBC039v1 Caicedo et al. 2018, the Broad Bioimage Benchmark Collection [Ljosa et al., Nature Methods, 2012]

1. Plugins > Macros > Record... を実行
2. 一連の解析を実施
3. recorder画面にてCreateボタンを押し、Script 
editorを起動

4. 不要な行を削除
5. 新しい画像を開く
6. Script editorからRunボタンを押し解析実行

自動化により同じ条件で大量の画像を解析可能となる

Fiji: https://imagej.net/ による解析
Schindelin, J. et al., (2012). Nature Methods, 9(7), 676–682. doi:10.1038/nmeth.2019

https://bbbc.broadinstitute.org/bbbc/BBBC039
http://dx.doi.org/10.1038/nmeth.2083
https://imagej.net/
https://doi.org/10.1038/nmeth.2019


課題1への異なるアプローチ ~AIアルゴリズムの利用~
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画像データ: BBBC039v1 Caicedo et al. 2018, the Broad Bioimage Benchmark Collection [Ljosa et al., Nature Methods, 2012]

元画像
インスタンスセグメンテーション

（ラベリング） 面積の定量

StarDist1やCellpose2が生物画像解析で多く実績を残している人気のAIアルゴリズム

1. Schmidt, U., Weigert, M., Broaddus, C. and Gene Myers. (2018) Cell Detection with Star-convex Polygons. MICCAI
2. Stringer, C., Wang, T., Michaelos, M., & Pachitariu, M. (2021). Cellpose: a generalist algorithm for cellular segmentation. Nature methods, 18(1), 100-106.

https://bbbc.broadinstitute.org/bbbc/BBBC039
http://dx.doi.org/10.1038/nmeth.2083
https://arxiv.org/abs/1806.03535
https://t.co/kBMXmPp3Yn?amp=1


stardist-napariのインストール
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1. Plugins > Install/Uninstall Plugins...を実行
2. stardist-napariを検索しInstall
3. napariを再起動

stardist-napari: https://github.com/stardist/stardist-napari, napari: https://napari.org/ による解析
Sofroniew, N. et al., (2024). Zenodo.doi:10.5281/ZENODO.3555620

https://github.com/stardist/stardist-napari
https://napari.org/
https://doi.org/10.5281/ZENODO.3555620


stardist-napariの実行
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1. Plugins > StarDist (stardist-napari)を起動
2. 必要に応じてパラメータを変更し（今回はデフォルト）Runボタンを押して実行

stardist-napari: https://github.com/stardist/stardist-napari, napari: https://napari.org/ による解析
Sofroniew, N. et al., (2024). Zenodo.doi:10.5281/ZENODO.3555620

https://github.com/stardist/stardist-napari
https://napari.org/
https://doi.org/10.5281/ZENODO.3555620


stardist-napariの実行結果
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StarDist AIモデルによるインスタンス
セグメンテーション結果が出力される

画像データ: BBBC039v1 Caicedo et al. 2018, the Broad Bioimage Benchmark Collection [Ljosa et al., Nature Methods, 2012]
stardist-napari: https://github.com/stardist/stardist-napari, napari: https://napari.org/ による解析
Sofroniew, N. et al., (2024). Zenodo.doi:10.5281/ZENODO.3555620

https://bbbc.broadinstitute.org/bbbc/BBBC039
http://dx.doi.org/10.1038/nmeth.2083
https://github.com/stardist/stardist-napari
https://napari.org/
https://doi.org/10.5281/ZENODO.3555620


napari-skimage-regionpropsのインストール
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1. Plugins > Install/Uninstall Plugins...を実行
2. napari-skimage-regionpropsを検索しInstall
3. napariを再起動

napari-skimage-regionprops: https://github.com/haesleinhuepf/napari-skimage-regionprops ,
napari: https://napari.org/ による解析 Sofroniew, N. et al., (2024). Zenodo.doi:10.5281/ZENODO.3555620

https://github.com/haesleinhuepf/napari-skimage-regionprops
https://napari.org/
https://doi.org/10.5281/ZENODO.3555620


napari-skimage-regionpropsの実行
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1. Tools > Measurement tables > Regionprops (scikit-image, nsr) を起動
2. 算出したいパラメータを指定し、Runボタンを押して実行

napari-skimage-regionprops: https://github.com/haesleinhuepf/napari-skimage-regionprops ,
napari: https://napari.org/ による解析 Sofroniew, N. et al., (2024). Zenodo.doi:10.5281/ZENODO.3555620

https://github.com/haesleinhuepf/napari-skimage-regionprops
https://napari.org/
https://doi.org/10.5281/ZENODO.3555620


napari: napari-skimage-regionpropsの実行結果
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インスタンスセグメンテーション結果
に対応した解析結果のテーブルが出力
される

画像データ: BBBC039v1 Caicedo et al. 2018, the Broad Bioimage Benchmark Collection [Ljosa et al., Nature Methods, 2012]
napari-skimage-regionprops: https://github.com/haesleinhuepf/napari-skimage-regionprops ,
napari: https://napari.org/ による解析 Sofroniew, N. et al., (2024). Zenodo.doi:10.5281/ZENODO.3555620

https://bbbc.broadinstitute.org/bbbc/BBBC039
http://dx.doi.org/10.1038/nmeth.2083
https://github.com/haesleinhuepf/napari-skimage-regionprops
https://napari.org/
https://doi.org/10.5281/ZENODO.3555620


課題2: 蛍光タイムラプス三次元画像を用いた細胞トラッキング解析
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元画像(3D+t) 解析結果

画像データ: C.elegans AZ212 H2B-eGFP 胚発生データ Celegans-5pc-17timepoints.tif (94 MB).
                            TrackMate tutorial (https://imagej.net/plugins/trackmate/tutorials/manual-track-editing) 

蛍光タイムラプス三次元画像において核のトラッキングにより、細胞系統樹を作成し解析する

TrackMate: https://imagej.net/plugins/trackmate/ による解析
Tinevez, J.-Y. et al., (2017). Methods, 115. doi:10.1016/j.ymeth.2016.09.016

http://samples.fiji.sc/Celegans-5pc-17timepoints.tif
https://imagej.net/plugins/trackmate/tutorials/manual-track-editing
https://imagej.net/plugins/trackmate/
https://doi.org/10.1016/j.ymeth.2016.09.016


課題2: 解析方針の検討
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画像データ: C.elegans AZ212 H2B-eGFP 胚発生データ Celegans-5pc-17timepoints.tif (94 MB).
Tinevez, J.-Y., TrackMate tutorial (https://imagej.net/plugins/trackmate/tutorials/manual-track-editing) 

• データサイズは？
￫ 291 x 354 x 41 x 17 (XYZT)と比較的小さい
￫ FijiのTrackMateで対応可能

• TrackMateの検出器は？（わかりやすくできると良い）
￫ シンプルな蛍光像なので、DoG or LoG検出器でOK

• 隣接している核がある
￫ 隣接領域を分離ための処理を追加

http://samples.fiji.sc/Celegans-5pc-17timepoints.tif
https://imagej.net/plugins/trackmate/tutorials/manual-track-editing


課題2: 解析方針の決定
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以下の論文Fig. 2より画像引用
Tinevez, J.-Y. et al. (2017) Methods, 115, 80–90. doi:10.1016/j.ymeth.2016.09.016

多機能な細胞追跡用Fijiプラグイン
以下の機能を組み合わせて利用
• スポット検出(Detection)
• 追跡(Linking)
• 細胞系統樹(Track scheme)
• 特徴量のプロット
• 各種出力機能（動画形式など）

多機能かつユーザーフレンドリーな
ソフトウェアであり人気

TrackMate1を利用し、細胞トラッキング・細胞系統樹解析を行う

1. TrackMate: https://imagej.net/plugins/trackmate/
Tinevez, J.-Y. et al., (2017). Methods, 115. doi:10.1016/j.ymeth.2016.09.016

https://doi.org/10.1016/j.ymeth.2016.09.016
https://imagej.net/plugins/trackmate/
https://doi.org/10.1016/j.ymeth.2016.09.016


TrackMateの起動
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画像データ: C.elegans AZ212 H2B-eGFP 胚発生データ Celegans-5pc-17timepoints.tif (94 MB).
Tinevez, J.-Y., TrackMate tutorial (https://imagej.net/plugins/trackmate/tutorials/manual-track-editing) 

解析対象の画像を開き、Plugins > Tracking > TrackMateからTrackMateを起動する

TrackMate: https://imagej.net/plugins/trackmate/ による解析
Tinevez, J.-Y. et al., (2017). Methods, 115. doi:10.1016/j.ymeth.2016.09.016

http://samples.fiji.sc/Celegans-5pc-17timepoints.tif
https://imagej.net/plugins/trackmate/tutorials/manual-track-editing
https://imagej.net/plugins/trackmate/
https://doi.org/10.1016/j.ymeth.2016.09.016


TrackMate: LoG detectorの実行
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画像データ: C.elegans AZ212 H2B-eGFP 胚発生データ Celegans-5pc-17timepoints.tif (94 MB).
Tinevez, J.-Y., TrackMate tutorial (https://imagej.net/plugins/trackmate/tutorials/manual-track-editing) 

LoG detectorを選択しEstimated object diameteを8に設定（データにより調整）し解析を実行

TrackMate: https://imagej.net/plugins/trackmate/ による解析
Tinevez, J.-Y. et al., (2017). Methods, 115. doi:10.1016/j.ymeth.2016.09.016

http://samples.fiji.sc/Celegans-5pc-17timepoints.tif
https://imagej.net/plugins/trackmate/tutorials/manual-track-editing
https://imagej.net/plugins/trackmate/
https://doi.org/10.1016/j.ymeth.2016.09.016


TrackMate: LoG detector結果のフィルタリング
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画像データ: C.elegans AZ212 H2B-eGFP 胚発生データ Celegans-5pc-17timepoints.tif (94 MB).
Tinevez, J.-Y., TrackMate tutorial (https://imagej.net/plugins/trackmate/tutorials/manual-track-editing) 

Qualityのヒストグラムからノイズ成分とシグナル成分の境目にThresholdを設定

シグナル成分

ノイズ成分

TrackMate: https://imagej.net/plugins/trackmate/ による解析
Tinevez, J.-Y. et al., (2017). Methods, 115. doi:10.1016/j.ymeth.2016.09.016

http://samples.fiji.sc/Celegans-5pc-17timepoints.tif
https://imagej.net/plugins/trackmate/tutorials/manual-track-editing
https://imagej.net/plugins/trackmate/
https://doi.org/10.1016/j.ymeth.2016.09.016


TrackMate: Simple LAP trackerの実行

2024年8⽉15⽇（⽊）JST-NBDCデータ解析講習会：AJACS（オンライン） 48

画像データ: C.elegans AZ212 H2B-eGFP 胚発生データ Celegans-5pc-17timepoints.tif (94 MB).
Tinevez, J.-Y., TrackMate tutorial (https://imagej.net/plugins/trackmate/tutorials/manual-track-editing) 

Simple LAP trackerを選択し、デフォルトのパラメータで解析を実行

TrackMate: https://imagej.net/plugins/trackmate/ による解析
Tinevez, J.-Y. et al., (2017). Methods, 115. doi:10.1016/j.ymeth.2016.09.016

http://samples.fiji.sc/Celegans-5pc-17timepoints.tif
https://imagej.net/plugins/trackmate/tutorials/manual-track-editing
https://imagej.net/plugins/trackmate/
https://doi.org/10.1016/j.ymeth.2016.09.016


TrackMate: TrackSchemeの表示
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画像データ: C.elegans AZ212 H2B-eGFP 胚発生データ Celegans-5pc-17timepoints.tif (94 MB).
Tinevez, J.-Y., TrackMate tutorial (https://imagej.net/plugins/trackmate/tutorials/manual-track-editing) 

Color spots byとColor tracks byをTrack indexに設定し、TrackShcemeを表示

TrackMate: https://imagej.net/plugins/trackmate/ による解析
Tinevez, J.-Y. et al., (2017). Methods, 115. doi:10.1016/j.ymeth.2016.09.016

http://samples.fiji.sc/Celegans-5pc-17timepoints.tif
https://imagej.net/plugins/trackmate/tutorials/manual-track-editing
https://imagej.net/plugins/trackmate/
https://doi.org/10.1016/j.ymeth.2016.09.016


TrackMate: トラッキング結果の手動修正（動画）
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画像データ: C.elegans AZ212 H2B-eGFP 胚発生データ Celegans-5pc-17timepoints.tif (94 MB).
Tinevez, J.-Y., TrackMate tutorial (https://imagej.net/plugins/trackmate/tutorials/manual-track-editing) 

不足しているLinkを追加し、不要なSpotとLinkを削除

TrackMate: https://imagej.net/plugins/trackmate/ による解析
Tinevez, J.-Y. et al., (2017). Methods, 115. doi:10.1016/j.ymeth.2016.09.016

http://samples.fiji.sc/Celegans-5pc-17timepoints.tif
https://imagej.net/plugins/trackmate/tutorials/manual-track-editing
https://imagej.net/plugins/trackmate/
https://doi.org/10.1016/j.ymeth.2016.09.016


TrackMate: 特徴量プロット機能の利用
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画像データ: C.elegans AZ212 H2B-eGFP 胚発生データ Celegans-5pc-17timepoints.tif (94 MB).
Tinevez, J.-Y., TrackMate tutorial (https://imagej.net/plugins/trackmate/tutorials/manual-track-editing) 

Spot, Link, Trackの特徴量（例: Spotの平均輝度）の時間変化をプロット

TrackMate: https://imagej.net/plugins/trackmate/ による解析
Tinevez, J.-Y. et al., (2017). Methods, 115. doi:10.1016/j.ymeth.2016.09.016

http://samples.fiji.sc/Celegans-5pc-17timepoints.tif
https://imagej.net/plugins/trackmate/tutorials/manual-track-editing
https://imagej.net/plugins/trackmate/
https://doi.org/10.1016/j.ymeth.2016.09.016


課題3: 病理スライド画像における細胞増殖領域定量解析
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細胞増殖マーカーであるKi-67陽性
細胞の割合を定量評価したい

Ki-67 proliferation index*: XX%

* https://www.cancer.gov/publications/dictionaries/cancer-
terms/def/ki-67-proliferation-index

画像データ: OpenSlide Test data OS-2.ndpi 
https://openslide.cs.cmu.edu/download/openslide-testdata/Hamamatsu/

細胞増殖マーカーKi-67を⽤いた
組織化学染⾊画像

全体図

拡⼤図

QuPath: https://qupath.readthedocs.io/ による解析
Bankhead, P. et al., (2017). Scientific Reports, 7(1). doi:10.1038/s41598-017-17204-5

https://www.cancer.gov/publications/dictionaries/cancer-terms/def/ki-67-proliferation-index
https://www.cancer.gov/publications/dictionaries/cancer-terms/def/ki-67-proliferation-index
https://openslide.cs.cmu.edu/download/openslide-testdata/Hamamatsu/
https://qupath.readthedocs.io/
https://doi.org/10.1038/s41598-017-17204-5


課題3: 解析方針の検討
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• 画像サイズは？
￫ 126,976 x 73,728と大きい
￫ クロップ画像を用いて解析
 or
￫ 病理ホールスライド画像に適した
ソフトウェアで解析

￫ QuPath1で対応可能

• Ki-67陽性細胞割合をどのように
評価するか？
￫ 全細胞のうち、Ki-67が濃く染まっ
ている細胞の割合を算出

画像データ: OpenSlide Test data OS-2.ndpi 
https://openslide.cs.cmu.edu/download/openslide-testdata/Hamamatsu/

細胞増殖マーカーKi-67を⽤いた
組織化学染⾊画像

全体図

拡⼤図

QuPath: https://qupath.readthedocs.io/  による解析
1. Bankhead, P. et al., (2017). Scientific Reports, 7(1). doi:10.1038/s41598-017-17204-5

https://openslide.cs.cmu.edu/download/openslide-testdata/Hamamatsu/
https://qupath.readthedocs.io/
https://doi.org/10.1038/s41598-017-17204-5


QuPathによる病理画像解析
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以下の論文Fig. 1より画像引用
Bankhead, P. et al. (2017) Sci Rep, 7, 16878. doi:10.1038/s41598-017-17204-5

病理ホールスライド画像向けに設計された
画像解析ソフトウェア
• 病理画像解析に特化した機能

• 腫瘍の識別
• バイオマーカーの定量評価

• ユーザーフレンドリー
• 使いやすさを重視した設計
• スムーズなホールスライド画像表示

• バッチ処理およびスクリプト機能
• 大量の画像データを効率的に処理

多機能かつユーザーフレンドリーなソフト
ウェアであり病理画像解析にとどまらず広
く使われている

https://doi.org/10.1038/s41598-017-17204-5


課題3: 解析方針の決定
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拡⼤図

全検出細胞(青+赤)

QuPathの Positive cell detection 機能で解析を実行する

Ki-67陽性細胞（赤）

陽性細胞検出

QuPath: https://qupath.readthedocs.io/ による解析
Bankhead, P. et al., (2017). Scientific Reports, 7(1). doi:10.1038/s41598-017-17204-5

https://qupath.readthedocs.io/
https://doi.org/10.1038/s41598-017-17204-5


QuPath: 解析対象領域の指定
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画像データ: OpenSlide Test data OS-2.ndpi 
https://openslide.cs.cmu.edu/download/openslide-testdata/Hamamatsu/

以下のツールを使って解析
対象領域を指定する。

• 矩形ツール
• 楕円ツール
• ポリゴンツール
• ブラシツール
• Wandツール

QuPath: https://qupath.readthedocs.io/ による解析
Bankhead, P. et al., (2017). Scientific Reports, 7(1). doi:10.1038/s41598-017-17204-5

https://openslide.cs.cmu.edu/download/openslide-testdata/Hamamatsu/
https://qupath.readthedocs.io/
https://doi.org/10.1038/s41598-017-17204-5


QuPath: Positive cell detectionの実行

2024年8⽉15⽇（⽊）JST-NBDCデータ解析講習会：AJACS（オンライン） 57

画像データ: OpenSlide Test data OS-2.ndpi 
https://openslide.cs.cmu.edu/download/openslide-testdata/Hamamatsu/

1. Analyze > Cell detection > 
Positive cell detectionを起動

2. パラメータ（今回はデフォルト）を
指定してRunボタンを押して実行

QuPath: https://qupath.readthedocs.io/ による解析
Bankhead, P. et al., (2017). Scientific Reports, 7(1). doi:10.1038/s41598-017-17204-5

https://openslide.cs.cmu.edu/download/openslide-testdata/Hamamatsu/
https://qupath.readthedocs.io/
https://doi.org/10.1038/s41598-017-17204-5


QuPath: Positive cell detectionの実行
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画像データ: OpenSlide Test data OS-2.ndpi 
https://openslide.cs.cmu.edu/download/openslide-testdata/Hamamatsu/

1. Annotationsタブに移動
2. Measurments テーブルから計測値
を確認
• Num Detections: 全検出細胞数
• Num Negative: 陰性細胞数
• Num Positive: 陽性細胞数
• Positive %: 陽性細胞割合

QuPath: https://qupath.readthedocs.io/ による解析
Bankhead, P. et al., (2017). Scientific Reports, 7(1). doi:10.1038/s41598-017-17204-5

https://openslide.cs.cmu.edu/download/openslide-testdata/Hamamatsu/
https://qupath.readthedocs.io/
https://doi.org/10.1038/s41598-017-17204-5


紹介したソフトウェアの公式ドキュメント
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https://imagej.net/Fiji

napari https://napari.org/

QuPath https://qupath.readthedocs.io/

最新の公式ドキュメントを確認

TrackMate https://imagej.net/plugins/trackmate/

各ソフトウェアのロゴ引用元: https://imagej.net/software/
https://imagej.net/plugins/trackmate/

https://imagej.net/
https://napari.org/
https://qupath.readthedocs.io/
https://imagej.net/plugins/trackmate/
https://imagej.net/software/
https://imagej.net/plugins/trackmate/


ImageJ プラグインまとめ
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• ImageJ List of Extensions: https://imagej.net/list-of-extensions

ImageJ List of Extensions: https://imagej.net/list-of-extensions Webサイトのスクリーンショット

https://imagej.net/list-of-extensions
https://imagej.net/list-of-extensions


ImageJ プラグインまとめ
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• Categories filterからフィルタリングが可能

ImageJ List of Extensions: https://imagej.net/list-of-extensions Webサイトのスクリーンショット

https://imagej.net/list-of-extensions


napari プラグインまとめ
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• napari hub: https://www.napari-hub.org/

napari hub: https://www.napari-hub.org/ Webサイトのスクリーンショット

https://www.napari-hub.org/
https://www.napari-hub.org/


QuPath プラグインまとめ
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• QuPath Docs extensions: 
https://qupath.readthedocs.io/en/latest/docs/intro/extensions.html

QuPath Docs extensions:
https://qupath.readthedocs.io/en/latest/docs/intro/extensions.html
Webサイトのスクリーンショット

GitHubhttps://github.com/
Webサイトのスクリーンショット

https://qupath.readthedocs.io/en/latest/docs/intro/extensions.html
https://qupath.readthedocs.io/en/latest/docs/intro/extensions.html
https://github.com/


image.scの利用
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image.sc: https://forum.image.sc/

image.scには生物画像解析に
関する質問やアナウンスメント
が日々投稿され、活発に議論が
行われている。

image.sc: https://forum.image.sc/ Webサイトのスクリーンショット

https://forum.image.sc/
https://forum.image.sc/


Biii (BioImage Informatics Index)の利用
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Biii (BioImage Informatics Index): https://biii.eu/

Biiiには生物画像解析に関する
以下のコンテンツがまとめら
れている。
• Training Material
• Dataset
• Software

Biii https://biii.eu/ Webサイトのスクリーンショット

https://biii.eu/
https://biii.eu/


解析方法の検討におけるChatGPTの活用
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ChatGPT4oは今回の解析ワークフロー
とほぼ同一の回答を返した

ChatGPT: https://chatgpt.com/ による出力

https://chatgpt.com/


解析方法の検討におけるChatGPTの活用
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https://chatgpt.com/


講義のまとめ
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• 生物画像解析の実践に必要な考え方

• オープンソース生物画像解析ソフトウェアを用いた生物画像解析の実例
• 課題1: 蛍光染色した核の面積定量 (Fiji, napari)
• 課題2: 蛍光タイムラプス三次元画像を用いた細胞トラッキング解析 (TrackMate in Fiji)
• 課題3: 病理スライド画像における細胞増殖領域定量解析 (QuPath)

• 生物画像解析を行なっていくために必要な情報の調べ方
• 各ソフトウェアの公式ドキュメント
• 各ソフトウェアプラグインのまとめ
• image.scフォーラムやBiiiの利用
• ChatGPTなどの活用



本日扱わなかった発表者に関連するトピック
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• ビッグデータに対応した画像解析ツール
• BigDataViewer: https://imagej.net/plugins/bdv/
• Mastodon: https://mastodon.readthedocs.io/
• ELEPHANT: https://elephant-track.github.io/

• 最新の画像解析AIツール
• Segment Anything Model (SAM): https://segment-anything.com/
• QuPath extension SAM: https://github.com/ksugar/qupath-extension-sam
 

• バイオイメージングデータのデータベース
• SSBD: https://ssbd.riken.jp/database/

AJACSオンライン12: https://togotv.dbcls.jp/en/20220831.html

https://imagej.net/plugins/bdv/
https://mastodon.readthedocs.io/
https://elephant-track.github.io/
https://segment-anything.com/
https://github.com/ksugar/qupath-extension-sam
https://ssbd.riken.jp/database/
https://togotv.dbcls.jp/en/20220831.html


ELEPHANTによる三次元画像解析（動画）
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Sugawara et al., (2022) eLife 11:e69380 https://doi.org/10.7554/eLife.69380
画像データ: Parhyale hawaiensis regenerating leg (demo dataset) https://zenodo.org/records/4549193

Fiji: Schindelin, J. et al. (2012). Nature Methods, 9(7), 676–682. doi:10.1038/nmeth.2019
BigDataViewer: Pietzsch, T. et al. (2015). Nature Methods, 12(6), 481–483. doi:10.1038/nmeth.3392
Mastodon: https://mastodon.readthedocs.io/ ELEPHANT: https://elephant-track.github.io/ による解析

https://doi.org/10.7554/eLife.69380
https://zenodo.org/records/4549193
https://doi.org/10.1038/nmeth.2019
https://doi.org/10.1038/nmeth.3392
https://mastodon.readthedocs.io/
https://elephant-track.github.io/


QuPath extension SAM（動画）
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QuPath: https://qupath.readthedocs.io/ による解析
Bankhead, P. et al., (2017). Scientific Reports, 7(1). doi:10.1038/s41598-017-17204-5

画像データ: OpenSlide Test data CMU-1.svs https://openslide.cs.cmu.edu/download/openslide-testdata/Aperio/
                 BBBC039v1 Caicedo et al. 2018, the Broad Bioimage Benchmark Collection [Ljosa et al., Nature Methods, 2012]

https://qupath.readthedocs.io/
https://doi.org/10.1038/s41598-017-17204-5
https://openslide.cs.cmu.edu/download/openslide-testdata/Aperio/
https://bbbc.broadinstitute.org/bbbc/BBBC039
http://dx.doi.org/10.1038/nmeth.2083


謝辞
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• 資料内で使用した画像データ提供元
• Broad Institute Broad Bioimage Benchmark Collection (BBBC)
• Open Slide Test Data
• Jean-Yves Tinevez (Institut Pasteur)

• 資料内で使用したソフトウェア
• Fiji: https://imagej.net/

• TrackMate: https://imagej.net/plugins/trackmate/
• napari: https://napari.org/

• stardist-napari: https://github.com/stardist/stardist-napari
• napari-skimage-regionprops: https://github.com/haesleinhuepf/napari-skimage-regionprops

• QuPath: https://qupath.readthedocs.io/

https://bbbc.broadinstitute.org/
https://openslide.cs.cmu.edu/download/openslide-testdata/
https://imagej.net/
https://imagej.net/plugins/trackmate/
https://napari.org/
https://github.com/stardist/stardist-napari
https://github.com/haesleinhuepf/napari-skimage-regionprops
https://qupath.readthedocs.io/
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Q&A



事前アンケート内リクエストへの回答
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「生物画像」と言っても、ミクロからマクロスケールまで様々ですので、それぞれの目的別にお
勧めの解析ソフトや解析方法をご紹介頂きたいです。

本講義で紹介したImageJ/Fiji, napari, QuPathのほか、タスクに特化したソフトウェアやプラグ
インがあります。

各ソフトウェアのプラグインページやBiii (https://biii.eu/) を活用することで効率よくソフトウ
ェアや解析方法を調べることが可能です。

https://biii.eu/


事前アンケート内リクエストへの回答
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普段，３次元組織を扱っているので３次元的な解析を行うための手法を学べたらと考えています。

QuPathは三次元画像を表示できますが、解析は二次元画像向けに特化して設計されています。

napariの三次元画像解析用プラグインやBigDataViewerと連携して動作するFijiプラグインの方
が適している場合もあるので、併せて検討するのが良いかと思います。



事前アンケート内リクエストへの回答
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cellposeなどで選択した多数の細胞のROI部を自動で解析するマクロの組み方などご教授いただ
けますとありがたいです。

ROI情報から形態解析を行う手順は本講義の内容が参考になるかと思います。

CellposeをFiji上でmacroから実行する方法としては以下が参考になりそうです。

Cellpose-Fiji: https://github.com/BioImaging-NKI/Cellpose-Fiji

https://github.com/BioImaging-NKI/Cellpose-Fiji


事前アンケート内リクエストへの回答
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Fiji（ImageJ）の使い方、スクリプトの基本的な書き方について勉強していく際に必要となる基
礎的知識についても取り上げていただければと思っております。

ImageJマクロの書き方については以下が参考になります。

• Introduction into Macro Programming: https://imagej.net/scripting/macro

• ImageJ Macro Language: https://imagej.net/ij/developer/macro/macros.html

ImageJのマクロの使い方についても、初心者向けに教えてほしい。

https://imagej.net/scripting/macro
https://imagej.net/ij/developer/macro/macros.html


事前アンケート内リクエストへの回答

2024年8⽉15⽇（⽊）JST-NBDCデータ解析講習会：AJACS（オンライン） 78

TrackMate について、SN比がそれほど良くない動画を用いるとSpotsが同じStackに複数現れ
たり、spotsが途切れたりするので、改善方法を教えて欲しい。

本講義で扱ったフィルタリング機能の利用をご検討ください。
また、TrackMate-StarDistなど検出にAIモデルを用いる手法を活用することも併せてご検討く
ださい。
TrackMate-StariDist: https://imagej.net/plugins/trackmate/detectors/trackmate-
stardist

https://imagej.net/plugins/trackmate/detectors/trackmate-stardist
https://imagej.net/plugins/trackmate/detectors/trackmate-stardist


事前アンケート内リクエストへの回答
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以前、動画において発現したGFPのマルチトラッキングに挑戦しましたがID管理などが難しく断
念しました。皆様どの様にされているのでしょうか？

本講義で紹介したTrackMateの利用をご検討ください。

大規模データのトラッキングにおいてはMastodon/ELEPHANTも併せてご検討ください。



事前アンケート内リクエストへの回答
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胃や腸の断面全層から粘膜の層だけを認識させて厚みを図ったり、核を認識させて上皮の下層と
上層で大きさのばらつきの違いを調べたりなどというタスクを行いたいと思っています。そのよ
うなタスクに応用できる、自動で画像内の特定のものを認識させて計測するタスクを扱っていた
だきたいです。

組織画像かと思いますので、QuPathと相性が良い解析となります。

粘膜層の認識にはPixel Classification1、核の認識にはCell Detection2およびStarDistの
QuPath extension3が適している機能となります。

1. https://qupath.readthedocs.io/en/stable/docs/tutorials/pixel_classification.html
2. https://qupath.readthedocs.io/en/stable/docs/tutorials/cell_detection.html
3. https://qupath.readthedocs.io/en/stable/docs/deep/stardist.html

https://qupath.readthedocs.io/en/stable/docs/tutorials/pixel_classification.html
https://qupath.readthedocs.io/en/stable/docs/tutorials/cell_detection.html
https://qupath.readthedocs.io/en/stable/docs/deep/stardist.html


事前アンケート内リクエストへの回答
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画像解析での標準化・質の担保のやり方を知りたいと思います。

解析のパラメータを固定しマクロ等で自動化することで解析の標準化が実現可能です。

質の担保については、あらかじめ別の方法（手動解析など）で参照となる結果を得ているテスト
データを準備しておき、自動解析の出力結果との違いが許容範囲かどうかを確認するという手順
が一般的となります。この際、正解率などの指標を用いることで定量的な解析の質の評価が可能
となります。



事前アンケート内リクエストへの回答
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生物画像解析の内容にて発表された論文の紹介が可能ならお願いします。これは読んでおくべき、
という論文があればご教示いただきたいです。

私が最近発表した生物画像解析関連の論文、プレプリントとしては以下がございます。
1. Sugawara, K., Çevrim, Ç., Averof, M. (2022) Tracking cell lineages in 3D by incremental deep 

learning eLife 11:e69380 https://doi.org/10.7554/eLife.69380 

2. Sugawara, K. (2023) Training deep learning models for cell image segmentation with sparse 
annotations bioRxiv https://doi.org/10.1101/2023.06.13.544786 

https://doi.org/10.7554/eLife.69380
https://doi.org/10.1101/2023.06.13.544786


事前アンケート内リクエストへの回答
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病理組織を解析するにあたって、炎症反応や組織状態（特に結腸、腎臓）の評価を行う際どのよ
うな点に着目すればよいのかを知りたい。
病理組織切片の適切な染色度合い（HE染色やマッソントリクローム染色などの、色素の濃すぎ
薄すぎなど）を教えてほしい。

解析したい条件に応じて細胞や組織の状態が変化し画像上に現れる場合は、その変化を検出でき
るように画像解析の方法を検討するということが基本的な方針になります。

適切な染色度合いを一律に議論することは難しいですが、染色度合いにより画像解析の結果が大
きく変化する場合があるので、なるべく同じ染色度合いで撮像することが望ましいです。

画像処理により染色度合いを標準化する手法もあります。
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輪郭が不明瞭なサンプルの効率的な認識を知りたい。

隣接するオブジェクトを分離できないという部分が課題になるようであれば、本講義で扱った
Watershed法が効果的な可能性があります。

また、輪郭が不明瞭でそもそも認識が難しい場合は、CellposeやStarDistなどAIモデルを学習さ
せることで高い認識性能が期待できます。
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論文化するときに指摘される点を教えてほしい。

画像解析の結果を再現するためのコードが求められるケースが増えています。

画像解析の手法開発においては、先行研究結果と比較した結果を求められるケースが多いです。
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組織染色切片の画像を用いた、各要素の分離のコツなどご教示いただければ幸いです。

QuPath上での染色の分離については以下をご参照ください。

https://qupath.readthedocs.io/en/stable/docs/tutorials/separating_stains.html

https://qupath.readthedocs.io/en/stable/docs/tutorials/separating_stains.html
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講義を聞いた後の自己学習のための参考資料（本やホームページなど）を教えてほしいです。

日本語のリソース:

• 「ImageJではじめる生物画像解析」三浦耕太先生, 塚田祐基先生編著 学研メディカル秀潤社

• 千々松良太先生によるQuPath解説: https://zenn.dev/rchiji/books/0025385037d794

英語のリソース:

• QuPath開発者のPete Bankheadによる生物画像解析の入門: https://bioimagebook.github.io/

• NEUBIASのYouTubeチャンネル: https://www.youtube.com/neubias

• Robert Hasseによる生物画像解析講座 Lecture BioImage Analysis 2020: 
https://youtube.com/playlist?list=PL5ESQNfM5lc7SAMstEu082ivW4BDMvd0U&si=9M5zub3QF
4b-6QoS

学研メディカル秀潤社
Webサイトより引用

https://zenn.dev/rchiji/books/0025385037d794
https://bioimagebook.github.io/
https://www.youtube.com/neubias
https://youtube.com/playlist?list=PL5ESQNfM5lc7SAMstEu082ivW4BDMvd0U&si=9M5zub3QF4b-6QoS
https://youtube.com/playlist?list=PL5ESQNfM5lc7SAMstEu082ivW4BDMvd0U&si=9M5zub3QF4b-6QoS

